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Product Warranty Statement

All products manufactured or distributed by Electronz Ltd are subject to the following,
and only the following, LIMITED EXPRESS WARRANTIES, and no others.

For a period of one () year from and after the date of purchase of a new Electronz Ltd
product, Electronz Ltd warranties and guarantees only to the original purchaser that such
a product shall be free from defects of materials and workmanship in the manufacturing
process. A product claimed to be defective must be returned to the place of purchase.
Electronz Ltd, at its sole option, shall replace the defective product with a comparable

new product or repair the defective product.

This expressive warranty shall be inapplicable to any product not properly installed or
properly used by the purchaser or end user, or to any product damaged or impaired by
external forces. This is the extent of warranties available on this product. Electronz Ltd
shall have no liability whatsoever for consequential damages following from the use of
any defective product or by reason of the failure of any product. Electronz Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without
limitation, all warranties of fitness for a particular purpose, warranties of description,

warranties of merchantability, trade usage or warranties of trade usage.
For off-road use only, not intended for highway vehicles.

Electronz Ltd License Agreement

The programme in this system is licensed not sold. Electronz Ltd grants the user a license
for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one
machine at a time. If the programme is transferred a copy of this license and all other
documentation must be transferred at the same time. The license may be terminated by
the user at any time. Electronz Ltd may terminate the licence if the user fails to comply
with the terms and conditions of this license. In either event the copy of the programme
must be destroyed.



PCLink Notice

Due to frequent upgrades, PCLink is not distributed with new Link

G4 ECU:s.

PCLink is available for free download at our website:

www.linkecu.com

Should internet download not be practical, a copy of the latest version
of PCLink on CD can be requested from your nearest Link Dealer.

PCLink - TunlngYour G4

Compatible with all G4 based ECUs

The most comprehensive, integrated ECU
tuning and logging software

Windows (XP, Vista & 7)
Mouse or Keyboard driven
Fully configurable multi-page layout

Large number of different *“views” for displaying
ECU and log data

Advanced time saving tuning features and
shortcuts

Single key access to all critical runtime values

ECU Configuration

Logically organised tree style navigation of ECU
settings

Comprehensive context sensitive help for all
features

Tuning

Popout settings menu saves screen space
Interactive 3D surface graph
Multiple table display

Configurable gauges, plotting and runtime

values
Warnings and Status information

All runtime displays automatically changed based
on selected table

Gauges

Variety of different configurable gauge types
Highly visible warnings

Logging

Record, save, download and analyse data log
files
Customisable color themes

Log analysis views: Time Plot, Navigator, XY
Plot, Statistics, Histogram, Value List, Parameter
List

Overlay and offset
comparison

laps and files for

Global time and cursor linking

Record, analyse and compare logs while tuning
an ECU
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| Introduction

Thank you for purchasing your Link Plug-In Engine Control Unit (ECU). Link G4 ECUs are an advanced, fully
programmable microprocessor controlled Engine Management System.

The G4 software platform boasts an impressiwe list of features giving a new level of user adjustment. This
flexibility allows the tuner to have complete control over the engine management system. G4 software
employs high resolution fuel and ignition tables with configurable load and RPM centres. When coupled with
up to six dimensional fuel and ignition mapping, barometric pressure compensation and intake air
temperature correction this gives an unprecedented level of tuning accuracy. All Link G4 ECUs are in field
upgradeable, there is no need to return the unit for software updates.

All Link G4 Plug-In Engine Management Systems are designed with flexibility and ease of installation in
mind. Link Plug-In systems are designed to either replace the circuit board inside the factory ECU
enclosure, or entirely replace the factory ECU. This provides an invisible install that requires minimal
modification to vehicle wiring and ECU mounting.

Link Engine Management Systems are designed with the final result in mind. Not only do they boast an
impressive range of performance features, but are designed with a focus on safety, reliability and drive-ability.
Howevwer, the ultimate success of your engine management upgrade is determined by how well the system is
installed and tuned.

Installing and tuning any after market engine management system is not to be taken lightly. G4 ECUs give
the tuner the control & flexibility that only top after-market engine management systems in the world can
provide. While every effort has been made to keep G4 ECUs as user friendly as possible, it should be
recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two important tasks:

1. This manual covers the installation of your G4 ECU. While it is not strictly essential that this work is
performed by an automotive electrician, the knowledge and tools available to these professionals makes it
highly recommended. Regardless of who does the installation, it is of utmost importance that instructions
provided in this manual are followed exactly throughout the installation.

2. Once the G4 ECU has been installed it will need to be tuned using a laptop computer with PCLink
software. Information on the configuration and tuning of the G4 ECU is detailed in the online help section
of PCLink. G4 ECUs are shipped pre-loaded with a base configuration that should be close enough to get
most engines running after a few application specific adjustments have been made. While hearing the
engine running on the new ECU for the first time is always a satisfying feeling, it is important to realise that
the job is not complete. The amount of tuning performed and the experience of the tuner are the two most
important factors in determining how happy you will be with your engine management system.

1.1 Safety Notice

Your Link Plug-In ECU is designed to enhance the performance of your vehicle. Howewer in all cases, your
vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on public roads.
Obey road rules at all times.

WARNING!

Failure to follow all installation and operating instructions may result in damage to
the Link ECU, personal injury, or harm to property.

1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring
harness are correct. However due to variations between vehicle models it is the installers responsibility to
check wiring connections BEFORE installing the ECU. Link will not be held responsible for any damage
caused by the incorrect installation of this product.

(c) 2009 Link ElectroSystems Ltd
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1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:
1. PCLink help, press F1 while running PCLink

2. Contact your nearest Link dealer. A Link dealer list is available on our website.

3. Link website: www.LinkECU.com

4. Technical Support Email: tech@LinkECU.com

5. Online Discussion Board: Available from the Link website.

The majority of questions received by the technical support team are clearly answered in the manuals. To
speed up your technical inquiry please consult the manuals to make sure that your question has not already
been answered.

(c) 2009 Link ElectroSystems Ltd
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2 Installation

This guide provides information on correctly and safely installing your new Link G4 Plug-In ECU.

2.1 ECU Handling Procedures

WARNING!!!
The following installation process will require handling of both the Link ECU and
factory ECU. Both of these are highly sensitive to electrostatic discharge and are
easily damaged. Follow the anti-static precautions given in this manual carefully
to awoid damaging electronic components. Warranty claims for ECUs damaged
by electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

A
Arad

Your body builds up an electrical charge as you mowve around. This charge can reach very high
wltages. Whenever given the opportunity this energy will attempt to discharge (usually through
your finger tips!). This can be fatal to most electronic components. Most people have
experienced an electrostatic discharge when they step out of their car or touch a metal bench
top.

1. The following guidelines describe precautions that can be taken to reduce the possibility of

damaging your ECU:
2. Work only on a conductive surface. A clean steel bench is suitable.
3. Always wear a wrist strap that is electrically connected to the conductive working surface.
4. Touch the working surface regularly.
5. Do NOT touch components on the circuit board.
6. Where possible, only handle the ECU by its plastic header.
7. Do NOT carry the ECU around without anti-static packaging.
8. Do NOT touch the bare terminals in the ECU header.
Obsenving the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

2.2 Fitting the ECU

Audi TT 8N
Information is provided to assist in fitting the ECU into the vehicle.

2.2.1 Fittinga VW/Audi |.8T ECU

Ensure you are following the given anti-static guidelines. The following steps outline the installation
procedure:

1. Removwe the factory ECU from the vehicle: Ensure the key is in the OFF position before proceeding. The
factory ECU is located inside the cavity below the front windscreen (under the black plastic panel). Unplug
the wiring connectors from the factory ECU, mowe retaining clip and slide the ECU out of its mount. DO
NOT touch the exposed pins in the factory ECU connector. Remowe the factory ECU from the vehicle and
place it to one side.

2. Install the Link ECU into the factory ECU's position. Reinstall any fasteners.

3. Connect the wiring loom to the Link ECU.

(c) 2009 Link ElectroSystems Ltd
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4. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual first.

: ]
i Retaining Clip
P

(c) 2009 Link ElectroSystems Ltd
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3 Additional Sensors

G4 Plug-In ECUs offer various options for the installation of additional sensors and devices. As a minimum it
is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP) sensor and Intake Air
Temperature (IAT) sensor. These parts can be purchased if required from your nearest Link dealer.

3.1 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure source after the
throttle body. It is common to T into the fuel pressure regulators pressure signal. Do NOT share this signal
with other devices such as boost gauges or blow off valves.

3.1.1 VWI/Audil.8T

The Link G4 VW/Audi 1.8T Plug-In ECU supports sewveral options for fitting of a MAP sensor. Any one of the
following options can be used:

1. Internal MAP Sensor — To ease installation the G4 VW/Audi 1.8T ECU is fitted with an internal MAP
sensor. This sensor is rated to 2.5 Bar absolute pressure. The internal MAP sensor is wired to An Volt 1.

2. MAP Sensor Wired Through AFM — To awoid running additional wires into the engine bay, a MAP signal
can be brought in through the AFM signal wire. The AFM signal is wired to An Volt 2. Refer to factory
wiring manuals for AFM wiring connections. Make sure the AFM can not be reconnected.

3. MAP Via Expansion pins in main header - The expansion pins provide power, ground, and analogue
channels for the connection of a MAP sensor.

Make sure that the correct An Volt channel has been selected as MAP sensor in PCLink and a MAP
calibration has been performed before attempting to start the vehicle.

3.2 Expansion Pins

The factory connector(s) spare pins are utilised to allow easy connection of additional ECU inputs/outputs.

Important points when wiring to the expansion connector:

Do not owverload the +5V Out pin. Although this is protected against ECU damage the +5V out signal also
provides power for other sensors.

Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

3.2.1 VW/Audi |.8T

= el 1 —
2412322120l ol1a]17[16]15[14[12[12[11]10]a [8 |7 |6 61 071 8[1 096 10 11} 124113
"45 |1134241 40]30[38137]3635[34[33[32[31]30[20[28 127 |26 25 %99 oofiofozfiosiiodho ”':!;T”a‘?"
1| 2 | [E2161160]58158 15715655 [54153152151|50[49]48 47145145144 90i911921934195196197) 1114115 [11g
1 e0[7a]78 (77 [76[75174173[72171170]69[6867 66165 164163 B2[23]84|85[3618738(89)
L=, L= L=I J
Pin Function Use
Pin 113 Aux Ign 6 Auxiliary Output
Pin 111 An Volt 10 Analogue 0-5V input
Pin 110 An Temp 3 Temperature sensor input
Pin 112 DI 9 Digital Input
Pin 98 + 5 Volt out Low Current +5V Supply
Pin 27 Sensor GND Sensor Ground Only

(c) 2009 Link ElectroSystems Ltd
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PC Tuning

G4 ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a Windows
based computer. PCLink may be downloaded from www.LinkECU.com. Note that when new versions of
PCLink are released they are posted on the website and may be downloaded at no cost. Also note that G4
ECUs must be used with the correct version of PCLink.

IMPORTANT!
The G4 ECU has on board USB.
BEFORE connecting the ECU to your laptop, the USB drivers must be installed.
Failure to install the drivers on your laptop first may result in windows assigning
incorrect drivers. These drivers will not work with the G4 ECU and are difficult to
uninstall. The correct USB drivers are installed as part of PCLink installation, as
described in the following section. Should internet download not be practical, a
copy of the drivers on CD can be obtained from your nearest Link dealer.

Installing PCLink

Due to the frequent updates PCLink is no longer shipped with each ECU. You will be required to download
the latest version of PCLink from: www.LinkECU.com

Should access to an Internet connection be impractical, the latest version of PCLink can be requested from
your nearest Link dealer on CD.

Installing from the web

1. Go to the above website and navigate to the downloads and software updates section.

2. Download the latest version of PCLink. When prompted to run or sawve the file, select sawe. It is
recommended to sawe this file on the desktop.

3. Double click the saved file and follow on screen instructions.

4. When prompted to install USB drivers, select yes. This may take some time.

5. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

Installing from a CD

. Insert the PCLink disk into you computer's CD ROM drive.

. Open 'My Computer'

. Double click your CD ROM drive.

. Double click the file labelled PCLinkSetup.exe (or similar name).

. Follow the on screen instructions.

- When prompted to install USB drivers, select yes. This may take some time.

. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

~NOoO O~ WNBRE

Communicating With Your ECU

After PCLink installation, you will be able to connect the G4 ECU to the laptop to perform set-up and tuning
work.

1. Connect the ECU to your laptop using a Link G4 ECU USB Cable. If not supplied with the ECU, these can
be purchased from a Link dealer. No other adapter or cabling is required. Connect the cable to the
connector labelled USB.

2. If this is the first time you have connected a G4 USB ECU to your laptop follow the driver installation

instructions that appear. When prompted if you want to install drivers select '‘Continue Anyway'.

. Start PCLink by double clicking on the PCLink icon on the windows desktop.

. Switch the key to the ON position. This will provide power to the ECU.

. In PCLink, under the 'Options' menu, select 'Connection’. The connection options dialogue will open.
Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. PCLink offers both mouse and keyboard control. To establish a connection between the PC and ECU
press the F3 key. The same process can be used to disconnect. If a successful connection is
established, PCLink will download settings from the ECU, otherwise you will be warned that an error has
occurred.

g b~ w
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7. Make sure the connection shows “ONLINE” in the top right corner of PCLink.
8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning the
ECUs power off all changes made will be lost.

(c) 2009 Link ElectroSystems Ltd
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5  Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

5.1 Firmware Version

It is recommended that the Link G4 ECU is running the most up to date firmware. Firmware version
information can be obtained by connecting to the ECU with PCLink and selecting 'ECU Information' under the
Help menu.

The latest firmware can be downloaded from our website with PCLink.

It is recommended that this is performed by an experienced Link dealer as new features may need to be
properly configured.

The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in PCLink.
Follow the on screen instructions to complete the firmware update process.

5.2 Base Configuration

All G4 Plug-In ECUs are shipped with base configuration settings. Note that these are provided to reduce
initial setup and tuning times. They are NOT recommended tuning values. PCLink includes base
configurations for various models. Download the appropriate base configuration into your ECU with PCLink
by connecting to the ECU (described in the Connecting To PCLink section of this manual), then selecting
'‘Open’ under the 'File' menu. Select the appropriate .pcl file and then select 'Open’. Downloading large
configuration files can take up to a few minutes. Be patient and acknowledge any messages PCLink shows.

5.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match the
Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP sensor also
allows the MAP sensor to be calibrated prior to tuning.

Link G4 ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This ensures that all
PCLink Tuning Software programs (pcl Files) give a consistent state of tune throughout the ECU range. This
allows a PCL file to be transferred between G4 based ECUs giving an equivalent state of tune providing all
factors affecting wolumetric efficiency are equal.

Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge
Pressure (MGP) as a load index.

To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.

2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP sensor.
Select the correct MAP Sensor Type.

. Under the 'Options’ menu, select 'MAP sensor calibration'.

. Follow the on screen instructions.

. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).

N o o~ W

. Perform a 'Store' by pressing F4.

5.4 TPS Calibration

The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management parameters
used by functions such as idle speed control,acceleration enrichment and motor sport features. It is
important that the ECU knows when the throttle is open and closed (or part way in between). The following
procedure calibrates the ECU to match the TPS:

(c) 2009 Link ElectroSystems Ltd
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1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.

. Under the Analog Channels menu, ensure that the correct An Volt channel is set to 'TPS (Main)'. Refer to
the pin functions section of this manual for details.

N

. Under the 'Options' menu, select 'TPS calibration'.

. Follow the on screen instructions.

. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).

. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.
. Perform a 'Store' by pressing F4.

N o O~ W

5.5 1AT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the intake
system. It is important that the ECU is calibrated to match the sensor installed in the engine. This procedure
is as simple as selecting the correct sensor type as follows:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.

. Click on 'Analogue Channel' in the configuration tree.

. Select the An Temp channel the sensor has been wired to.

. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.

. Select the correct Temp Sensor Type'.

. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
. Ensure that IAT reads the correct temperature.

0 N O o~ WDN

. Perform a 'Store' by pressing F4.

5.6 Input and Output Setup

As the Link G4 Plug-In ECUs are designed to run several models there are a few items that must be set-up
to make the ECU specific to your model.

The Pin Functions section of this manual gives a list of the functions of each channel based on the target
vehicle.

It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:

All Auxiliary Output Channels
Use the Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs

Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

All Analogue Volt and Temperature Inputs

Look at the Analogue Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

5.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have been
completed. Only after all pre-start checks have been made should an attempt be made to crank the engine.
The following steps must be performed before an attempt is made to start the engine to ensure the G4 ECU
is calibrated to precisely measure engine position.

1. Connect the ECU to PCLink.

2. Select 'Fuel', then 'Fuel Set-up":
a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.

(c) 2009 Link ElectroSystems Ltd



Plugln Installation Manual

3. Click on ‘Triggers’ then ‘Calibrate Triggers’.

4. Perform the correct trigger calibration procedure specific to your vehicle as described in the PCLink online
help (Press F1).

Note that trigger calibration must be performed again once the engine is running. Due to the acceleration and

deceleration of the crankshaft at low speeds, an inaccurate measurement of engine timing is usually made.

Also it is often harder to see timing marks with a timing light at slow engine speeds. Trigger calibration

should be checked again at between 2000-4000 RPM where engine speed is stable and a more consistent

timing reading can be obtained.

(c) 2009 Link ElectroSystems Ltd
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6 First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the engine is
now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to PCLink.
3. Access the runtimes values by pressing the F12 Key, click the ‘Analog' tab:
a. TPS — spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration.

b. MAP — should read approx 101 kPa (at sea level) with the engine not running. If not, check the MAP
Sensor Type setting and perform a MAP Calibration.

C. ECT — should read current engine temperature.
d. IAT — should read current intake air temperature.

e. Digital Inputs (click the 'Digital' tab) — Operate switches connected to any digital inputs while watching
the runtime value to ensure they operate as expected.

4. Rectify any faults found in Step 3.

5. Locate the 'Master Fuel' setting. This can be found in the ECU Settings Menu under: Fuel > Fuel Setup >
Fuel Main.

a. This will need to be adjusted during or just after start-up.

6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning. If necessary adjust the Master setting to enrich/lean the engine (increase to enrich).

7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count one or
two on the first engine revolution.

9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best possible running.

10.The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don’t forget to keep an eye on engine temperature.

11.0Once the engine is warmed up and running well, perform another trigger calibration (known “as setting the
base timing”).

12.Perform a Store by pressing F4.

6.1 Final Checks

To awoid potential engine damage and wasted time, the adjustments presented in the following sections must
be made before attempting to start the engine.

For further help on any of the settings discussed below, consult the online Help in the PCLink Tuning
Software. Online help can be invoked by pressing F1, or right clicking any item and selecting ‘What’s this?'.

Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:

1. Ensure the ECU and all associated components are connected and correctly wired/installed.

2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up procedure.
3. Check all oil and water levels are correct.

Connecting to PCLink Tuning Software

Use the following procedure to establish a connection between your Link ECU and PCLink Tuning Software
tuning software.

1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to PCLink Tuning Software as described in the
'‘Communicating with your ECU' section of this manual.

(c) 2009 Link ElectroSystems Ltd
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6.2 Essential Tuning Adjustments

It is assumed that at this stage all set-up procedures described in previous sections have been completed
and the engine is running. The following steps detail correct set-up procedures for some of the more critical
ECU parameters (note that MAP Sensor Calibration should have already been completed by now):

Injector Voltage (Dead-time) Correction

There is always a delay between the injector being energised and the injector actually opening. Likewise,
there is a small delay between the injector being de-energised and the injector closing. The opening time is
considerably longer than the closing time, however the overall result is that less fuel will flow for a given pulse
width than would be expected with an ‘ideal injector'. To compensate for this the injector pulse widths are
increased to compensate for this 'dead-time’. The dead-time for a given injector is a function of the battery
wltage, differential fuel pressure and the type of injector driver (saturated or peak and hold). A typical dead-
time at 3 Bar differential fuel pressure and 14 wolts is just under 1ms (ms = millisecond = 1 thousandth of a
second).

In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only
variable that is changing will be the battery woltage (this changes with electrical load and sometimes engine
speed). Without correction, the changes in dead-time will cause the engine to run lean when the woltage
drops. If the Injector Voltage Correction is properly set-up then changes in the battery wltage will not affect
the air/fuel ratio.

The injector dead-time table allows the dead-time for different battery wltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system woltage.

Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine.

To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set wltage. Vary the
supply woltage to the injector and measure minimum pulse width at which the injectors will flow for a
particular woltage. This is the required dead-time for that injector at that tested woltage.

To determine injector dead-time on a running engine, with the engine fully warmed and operating at stable air/
fuel ratios (a very precise AFR meter is required — a narrow band O2 sensor will not suffice), electrical drain
needs to be applied to the system; the preferred method is disconnecting the alternator main fuse. Battery
load testers are also useful here too.

Watching the air fuel ratios change while the battery wltage drops, the dead-time table can be trimmed to
maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth curve
needs to be maintained at all times.

NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.
Master

Master should be set so that the numbers in the middle of the fuel table end up around a value of 50. This is
to allow sufficient span of the numbers in the main fuel table.
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7 Pin Functions

A list of pin functions is provided, this is useful when configuring your ECU through PCLink.
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7.1 VW/Audi 1.8T

VW/Audi 1.3
Auxiliary Outputs
Aux 1 Tacho
Aux 2 Turbo Recirculation valve
Aux 3 Wastegate Solenoid
Aux 5 Fuel Pump Relay
Aux 6 Purge Canister
Aux 7 EPC (Check Engine) light
Aux 8 E-throttle Relay
Aux 9 E-Throttle Motor (+)
Aux 10 E-Throttle Motor (-)
Aux - Injection Outputs
Aux Inj5 Oxygen Sensor #1 Heater
Aux Inj 6 Intake Cam Solenoid
Aux Inj 7 Oxygen Sensor #2 Heater
Aux — Ignition Outputs
Aux - Ign 6 Expansion Pin
Analog Channels
AnVolt 1 Internal MAP Signal
AnVolt 2 Air Mass Meter Signal (AFM)
An Volt 3 Throttle Position Sensor (Main) Signal
AnVolt 4 Throttle Position Sensor (Sub) Signal
An Volt 5 Foot Position Sensor #1 Signal
An Volt 6 Foot Position Sensor #2 Signal
AnVolt 7 Intercooler Pressure Signal
An Volt 8 Oxygen Sensor # 1Signal
AnVolt 9 Oxygen Sensor #2 Signal
An Volt 10 Expansion Pin
An Temp 1 ECT Signal
An Temp 2 IAT Signal
An Temp 3 Expansion Pin
Digital Inputs
DI 1 Vehicle Speed Signal
DI 2 Brake Pedal Switch #1
DI 3 Brake Pedal Switch #2
Dl 4 Clutch Pedal Switch
DI 5 Pow er Steering Switch
DI 6 A/C Request Signal
DI 7 A/C Compressor Signal
DI 8 Crash Signal
DI 9 Expansion Pin
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8 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire side).

8.1 VW/Audi l.8T

=l =l =L
24]23l22]21 [20]1g] G107 CBH OSf 10 11 12 13
4 | 5 | [igliolaslaolsosalarlas oooshotfoaiatodos 1191120 12
1 3|2 62[616059]58[67[56]55[54[53]52[51[50[40]48]47]46]45 144 B0 1E2R3pB4R5]%6[7] “*PITHIIISHE
81]80[78[78[7776]7574173172(71[70l69]686 7666564163 B2183/84(85[86137 188189
L= L=, L=, J
VW/Audi 1.8T V1.3
Pin ECU Function Pin ECU Function
5 Inj 5 88 Inj 4
27 Sensor GND 89 Inj 2
29 An Volt 2 92 An Volt 3
34 An Volt 6 93 An Temp 1
35 An Volt 5 94 lgn 4
37 Aux 1 95 Ign 2
39 Dl 4 96 Inj 1
40 DI 6 97 Inj 3
41 DI 7 98 + 5 wolt out
48 Aux 7 101 An Volt 7
49 DI 5 102 lgn 1
54 DI1 103 Ign 3
55 DI 2 104 Aux 3
56 DI 3 105 Aux 2
58 CAN Low 106 Knock 1
60 CAN High 107 Knock 2
63 Inj 7 110 An Temp 3
64 Aux 6 111 An Volt 10
65 Aux 5 112 DI 9
67 DI 8 113 lgn 6
69 An Volt 9 115 Inj 6
70 An Volt 8 117 Aux 9
82 Trig 1 118 Aux 10
84 An Volt 4
85 An Temp 2
86 Trig 2
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9 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that have
not been tested. For this reason issues can arise. Please contact your nearest Link dealer when suspecting
a compatibility issue.

9.1 VW/Audi |.8T

There are currently no known issues.
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